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Living in the information age, we benefit tremendously from the abundance and the accessibility of 
information. Global communication, modern medicine, and computer technology are just few of the 
endless examples of information age products and services that continually improve the quality of 
our lives.
 
Because information is valuable, the way you work is largely influenced by its abundant and 
constantly changing nature. Your ability to absorb, assimilate, and communicate information hence 
dictates the success of your work. Whether you are a working professional or a student, you must 
deal with a large amount of vital information in a timely and effective manner.

Did you know that exams, job training, business procedures, and sales presentations all share 
common traits? They do: the more you know, the better off you are. And the more you can remember
and integrate the information vital to your work, the better you become at solving real-world 
problems. The tool for the job is DigiCard. 

The purpose of DigiCard is to help you excel and put you ahead. Simply think of DigiCard as a 
multimedia flash card program, designed with power in mind. DigiCard helps you memorize and 
assimilate information in a variety of effective ways. And DigiCard lets you accomplish this via a 
friendly and intuitive interface. This means that you can transform a large amount of information into 
your personal knowledge base faster and better than ever before!

Whether you are memorizing a vocabulary list or mastering the national medical board, DigiCard 
makes learning a much less painful and possibly even a fun and rewarding experience!



Professionals
Here are examples of how DigiCard can benefit you professionally while saving time and money:
n Preparation for state and national board exams for brokers, insurance agents, engineers, 

doctors, lawyers, CPAs, and other professionals.
n Mastering procedures and protocols.
n Assimilation of product information for sales.
n Improvement in speeches and presentations.
n Facilitation of on-the-job training to save your business time and money.

Students
If you are a student, DigiCard will become your best friend.
n DigiCard will help you decrease your study time, increase retention and boost your grades. Many

DigiCard users report that they were able to recall volumes of information not otherwise possible 
without DigiCard, earning them top scores on exams.

n Use DigiCard to memorize key facts and salient points for smooth and successful speeches and 
presentations.

n DigiCard is so easy to use, it is also great for kids!



DigiCard is an effective learning tool to help you save time and improve your everyday professional 
and academic life. Here are eight reasons why:

n DigiCard is interactive; you are now participating in the learning process rather than being just a 
passive observer (i.e., reading books and listening to lectures).

n DigiCard presents your learning materials to you in six possible ways. You decide what method is
best for you and your particular subject.

n The key to learning is repetition. DigiCard greatly facilitates and accelerates this process for you.
n The prerequisite to understanding is memorization. DigiCard not only helps you memorize your 

material, it encourages your mind to integrate the information. This occurs because the human 
mind has a great tendency to create a conceptual framework around related ideas.

n Even the act of making cards reinforce learning. The mental task of deciding whether to include 
or exclude information from a card and the act of data entry serve as two different modalities to 
complement your learning.

n DigiCard lets you use time efficiently; all of your learning and reviewing time can be used to 
master cards containing difficult or unfamiliar concepts when you discard those that you know 
well.

n DigiCard stimulates your recall time and efficiency with the automatic presentation feature (Card 
Shooter). You can now play games using your learning material as you try to beat the clock to 
the answers!

n Research has shown that by combining visual with audio information, retention, recall, and even 
motivation can be increased significantly. The multimedia learning process stimulates the senses
and turns learning into a truly exciting experience.



 See Also...

While DigiCard is easy to use, the following sections are designed to make sure you get the most out
of DigiCard. We will begin with an overview that will get you acquainted with the basic components of
the program. Then, we will go through a simple exercise and make your first DigiCard file. The 
sample file "States and Capitals" is provided to demonstrate the various ways you can review your 
learning materials.

DigiCard consists of two main modules, the Editor and Viewer. The Editor allows you to make up 
your cards. That is, it lets you enter the questions, answers, and keywords (subjects and topics). You
can edit and revise any information in your DigiCard file at any time using the Editor.

The Viewer presents to you the cards you have made using the Editor. The Viewer is flexible; you 
can instruct the Viewer to present cards in ways that match your study style, the subject matter, or 
even your mood. For instance, the Viewer can show you your cards by three styles of presentation 
(Sequential, Random, and KeyLink). Or you might decide to reverse the order of the usual question-
answer format to that of an answer-question format. Together, you have six different presentation 
schemes, which are designed to significantly improve the way you memorize and integrate 
information. Time is spent efficiently while reviewing, because when you discard those cards that you
know well, you are studying only unfamiliar materials and saving valuable time. Since the whole 
process is interactive, studying no longer has to be boring!

In the next two sections are two tutorials to get you aquainted with Editor and Viewer functions. 
When you strike out on your own, remember that help is with you every step of the way. If there is an
object on the screen you have questions about, just point to it and look at the status window (located 
at the right side of the tool bar) for a brief description. If you need additional information, press the 
[F1] key.

Tutorial 1: A Simple Exercise
Tutorial 2: Sample File "States and Capitals"



See Also...
Presentation Style
Presentation Format



Presentation Style
Sequential
Random
KeyLink



Sequential Presentation Style
n Cards are presented sequentially, from the first card to the last.
n This is the default presentation style.
n Tip: Use sequential presentation for initially reviewing your cards or for subject matters that are 

sequential in nature (i.e., speeches).



Random Presentation Style
n Cards are presented randomly from a constantly shuffled deck.
n Tip: Randomly presented cards, over time, fosters associative learning. The random nature will 

provide new points-of-view and allow your mind to integrate related information much more 
quickly than the traditional method of study.



KeyLink Presentation Style
n In KeyLink, DigiCard surveys and groups your cards together according to keywords. DigiCard 

then selects one group randomly for presentation. See Tutorial 2 in this help file for a 
demonstration of the KeyLink feature.

n Although keywords (subjects and topics) are optional, some of your cards must contain one or 
more keyword in order to take advantage of KeyLink presentation.

n The frequency at which a group is selected for KeyLink presentation is proportional to the 
number of cards the group contains. Thus, you will see cards from a large group more often than
small groups.

n Tip: KeyLink is ideal for viewing conceptually related cards together. Viewing related cards as a 
group stimulate the formation of a mental framework and ensures that you are seeing every card 
in the proper context.



Presentation Format
Question First
Answer First



Question First Format
n The question comes before the answer for each card.
n This is the default presentation format.



Answer First Format
n Exact reverse of the question first format -- the answer is followed by the question for each card.
n Tip: Ideal for vocabulary and other short question/answer pairs. The reversal is especially 

beneficial for reinforcing your knowledge of the subject matter at hand.



To make it easier to follow, select 'Print Topic' from the File menu for a printout.

This section will help you get started making your first DigiCard file and introduces you to the Viewer.
Simply follow the steps below:

1 Using your learning material, let us begin by making a file of several cards. From the File menu, 
select New. In the Editor, click once on the window labeled 'Question'. You will now see the 
blinking cursor in the question window. Now type in your first question.

2 After you enter the question, you can either press the [Tab] key or click once on the window 
labeled 'Answer'. The blinking cursor is now in the answer window. Now answer the question you
have posed. Take care to phrase your answer as concisely as possible, as this will increase 
learning efficiency.

3 Now you are ready to save the card. Using the mouse pointer, push the New Card button to 
simultaneously save the current card and add a new card.

4 At this time, note that the toolbar will inform you that you are on "Card 2 of 2." Repeat steps 1 
through 3 a few more times. Save the file by selecting Save As under the File menu and provide 
a name for your DigiCard file.

5 When you have ten or more cards, we are ready for a demonstration of Viewer features. Switch 
to the Viewer module by pressing the snow icon button.

6 In the Viewer, you will notice right below the tool bar the word "Sequential." This indicates that 
the sequential presentation style is currently active. We will use sequential presentation for 
reviewing your newly created cards, making sure the questions and answers are phrased to your
liking.

7 Begin your review. To see the answer, push the Show Answer button. You will notice that the 
button label changes to 'Next'. Push this button when you are ready to move on.

8 Repeat this process for all of your cards. At any time if you want to edit the content of your card, 
double click on the Viewer window or press the sun icon button.

9 Now we will try out the Random style of presentation. Push the Random button under Options. 
Press OK.

10 Notice that card presentation is totally randomized now. Randomly presented cards, over time, 
fosters associative learning. Whenever you encounter a question, try hard to state the answer 
before you go on to the next card.

11 As you go through the stack a few cycles, you will notice that information will begin to stick. 
Before you disable a card containing information that you think you know well, make sure you 
see the card several more times to solidly reinforce the learning. To disable a card, push the 
Discard button.

12 When all cards are disabled, you will be notified of this and DigiCard will automatically enable all 
cards. Before we end this tutorial, try the reverse question-answer format. Go to Options and first
select the Format tab and then push the Answer First button. Now studying can be just as 
challenging as playing Jeopardy!

Congratulations! You have completed your first DigiCard tutorial. As you become more familiar with 
DigiCard, be sure to check out the next tutorial. In the next tutorial, we will explore three powerful 
learning features: KeyLink, Keyword Selection, and Card Shooter.



To make it easier to follow, select 'Print Topic' from the File menu for a printout.

If you are new to DigiCard, be sure to go through tutorial 1 (last page) before beginning this one. In 
this tutorial, we are going to explore three powerful features in DigiCard: KeyLink, Keyword 
Selection, and Card Shooter. Simply follow the steps below:

1 From the File menu, open the file 'SAMPLE.CRD' (located in the DigiCard program directory). In 
this sample file, states are categorized by time zones (Subject and Topic have been renamed to 
Zone 1 and Zone 2). For instance, all of the cards representing states in the Eastern standard 
time zone contain the keyword "Eastern."

2 After the file loads, switch to the Viewer module. You will notice that the Viewer module is active 
for KeyLink presentation. As you place the mouse arrow on the Show Answer button, note that 
the status window is displaying the time zone (in brackets) -- this indicates the active keyword. In
this case, keywords are time zones of the United States.

3 As you browse the cards, DigiCard will present every state located in the active time zone. After 
the last state of the time zone is presented, DigiCard will randomly select another time zone. Try 
this for yourself.

4 If you prefer, you can keep the active keyword from being displayed in the status window by 
selecting 'Hide Keyword' from Options.

5 The way you can link cards together is really very simple. Switch over to the Editor and note that 
there are 51 cards total and the states are in alphabetical order. Navigate through the deck by 
using the arrowhead buttons. Notice that with a few exceptions, every card contains only one 
keyword in the Zone fields.

6 You have the ability in DigiCard to activate only a subset of the time zones in the stack. Let's say 
that you have mastered all of the time zones except for two, and you want to review only these 
two zones. Under Options, click on the Selection tab and highlight two zones of your choice. Now
DigiCard will show you only those cards in the selected time zones. Keyword Selection also 
works in Sequential and Random presentation styles.

7 Let's turn this exercise into a game. Switch to the Viewer and press the Shooter button. Each 
side of every card is now displayed for two seconds. Now you can test your knowledge of US 
States and Capitals against the clock! When you are done, press the Shooter button again (now 
labeled 'Stop') to end Card Shooter.

Congratulations! You have learned much by following through this tutorial. This exercise illustrates 
how you can easily add keywords to your cards to take advantage of Keyword Selection and KeyLink
Presentation. Viewing related cards in groups in KeyLink is advantageous because it stimulates the 
formation of a mental framework and ensures that you are seeing every card in the proper context. 
Keyword Selection offers a convienient way by which individual subjects and/or topics can be 
studied. The Card Shooter feature adds a temporal challenge that prepares you for time-limited 
events such as examinations and speeches.



The following sections will serve as a visual guide to the various interface elements in DigiCard. 
Choose a section below:

Menu and Tool Bar
Editor Interface
Viewer Interface



Editor Interface
Viewer Interface

Click an object you need help on...



Menu and Tool Bar
Viewer Interface

Click an object you need help on...



Menu and Tool Bar
Editor Interface

Click an object you need help on...



Launching DigiCard

How do I launch DigiCard data files (CRD files) from an icon?    
To run a DigiCard data file from an icon, create a new program item in the Program Manager. In the 
Description field, enter the name of the data file. Next, in the Command Line field enter the full path 
of the DIGICARD.EXE file, leave a space, and enter the full path of the data file (i.e., 'C:\DIGICARD\
DIGICARD.EXE C:\DIGICARD\SAMPLE.CRD'). Press OK. A new icon will be created that will allow 
you to simultaneously start the DigiCard program and load the data file.

How do I launch DigiCard through its data files (CRD files)?    
In order to launch DigiCard through its data files (i.e., using File Manager), the CRD extension must 
be registered with DigiCard. By default, Windows associates the CRD extension with the Cardfile 
applet. If you do not use Cardfile or do not anticipate launching Cardfile through its data files, the 
CRD extension can be registered to DigiCard very simply.

If the included Install program is used to setup DigiCard, no action is needed on your part since the 
Install program automatically registers the CRD extension to DigiCard. 

However, if you did not use the Install program to setup DigiCard, you can manually switch the 
association. Using File Manager, log onto the DigiCard directory. Find the DIGICARD.REG file and 
double click on it. A confirmation box will pop up to notify you of the new association.

If you would like to revert the CRD extension back to Cardfile, launch UNREGIST.REG (also in the 
DigiCard directory). This will undo the DigiCard registration.

Editing Operations

How do I exchange data between DigiCard and other Windows programs?    
Cut, Copy, and Paste offer a convenient way by which DigiCard can exchange data with other 
Windows applications. For instance, you may paste information from a word processor document 
into the DigiCard Editor and vice versa.

How do I save a card and add a new card simultaneously?    
Simply press the New Card button. In fact, anytime you move away from a card that has been edited,
changes are saved automatically. The Save button only needs to be pushed when you have just 
edited a card and need to immediately exit the file.

File Operations

How do I export data out of DigiCard?    
DigiCard file structure is based on the Microsoft Access 1.1 database engine. Using Access, 
DigiCard data can be flexibly manipulated and translated to many other database formats (i.e., 



dBase, FoxPro, etc).

As for exporting to ASCII text, look for this feature in a near future release of DigiCard.

How do I convert data from other flash card programs into DigiCard?    
If you have already invested time and energy into building flash cards for another program, 
converting the files to DigiCard format may be a relatively painless process. If your card files are (or 
can be) saved to ASCII text format, simply follow the steps below:

1 From the File menu, select Import Text.
2 Open your text file. TextPad will be activated automatically and you will see your file contained 

within.
3 From the Edit menu, select Drag 'n Drop so that it is checked.
4 Highlight the question you want to incorporate into DigiCard. Then simply drag the question and 

drop it into the question window.
5 The process for the answer is the same. When you are done with the card, press the New Card 

button.
6 Repeat steps 4 and 5 for the other question-answer pairs.

Distributing CRD Files

In general, how do I distribute CRD Files?    
Associated with each CRD file is a configuration file with the extension CFG. The CRD files contain 
text data and multimedia file locations, while the CFG files contain Options settings. When 
distributing DigiCard data, be sure to package both the CRD and CFG together.

How do I distribute multimedia CRD Files?    
Multimedia files (all graphics and sound files) are external files accessed by DigiCard. Because of 
this, all associated multimedia files must be included with the multimedia CRD file for distribution. As 
long as all files are installed to the same directory as the CRD file, DigiCard will have no trouble 
finding and playing back the multimedia add-ins.



When you register DigiCard, you will receive many benefits. These include:

n Removal of registration reminders.
n Automatic conversion of version 2 files to the latest format.
n Sort feature, supporting ascending or descending sorting of any one of the four fields (question, 

answer, subject, or topic).
n Disk containing the latest registered version of DigiCard promptly mailed to your address.
n "Strategies for Success," a companion guide to DigiCard which is loaded with helpful tips to 

boost your academic and professional performance.
n 25% discount for graphics and text scanning (please see Special Offers section).
n One year free CompuServe / Internet / BBS / Telephone / US Mail support.
n SPECIAL PROMOTION: Perpetual free upgrades of DigiCard for Windows! Offer expires 9/1/95. 

Offer applies to the original registrant onlly. After this date, registration includes one free major 
upgrade.

      Click Here to Register!

If you would like the author to contribute 40% of the received registration fee to charity, please 
provide the name and address of the organization. Thank you!



You have a choice to either register DigiCard through CompuServe or by regular mail. Simply click 
on a choice below:

      Registration via CompuServe

      Mail-In Registration

Site licensing is also available. Please contact the author for information.



n To register through CompuServe, GO SWREG (part of basic service) and select registration ID # 
2211.

n The registration fee of $23.53 per copy will be billed to your account.
n The latest registered version of DigiCard will be mailed promptly.
n Please contact the author if you would like to benefit a charity through your registration.

How to Contact the Author



The author is dedicated to the success of DigiCard users. For product support and/or suggestions on
how DigiCard can be improved, you may contact the author, Rob Chen, by any of the following ways:

n CompuServe ID: 73542,1232
n Internet Address: rchen@orion.oac.uci.edu
n BBS: Chips+ Connection (11 nodes)

1-714-556-3207
1-714-556-3208
1-714-760-3265

n Phone/Fax: 1-714-856-0451
n US Mail: 6014 Verano Place

Irvine, CA    92715-3159

About the Author



About the Author

Hi, my name is Rob Chen and I am currently attending graduate school at University of California, 
Irvine.    I am now in my third year of study. I aspire one day to help mentally retarded children by way
of medical care and research.

DigiCard is initially the product of interest in helping my classmates and myself fufill a need in having 
an effective learning tool. Because of DigiCard's success, I was encouraged to enhance and release 
the program to the general public. DigiCard is charityware because I firmly believe that there are 
many worthwhile causes that are in need of support. DigiCard thus fufills both my desire to help 
needy people and environmental concerns and to create a good program that helps people study 
and achieve their goals.

I appreciate any suggestions concerning this program. Please contact me and let me know of your 
experience.



To print the following form, select 'Print Topic' from the File menu.

n Please register me for DigiCard and send the latest version.

Name: _______________________________________________________

Occupation: ____________________ Company: _____________________

Address: _____________________________________________________

City: _______________________    State: __________    Zip: ____________ 

Country: ________________    E-Mail or Telephone # __________________

n Registration:

# of Copies: _____    x    $20.00    = $ _______

Shipping and Handling: $          3.53

TOTAL:               US $ _______

n Diskette format:  _____ 3.5", 1.44M              _____ 5.25", 1.2M

n From where did you obtain this copy of DigiCard?

____________________________________________________________

n Comments / Suggestions:

____________________________________________________________

____________________________________________________________

____________________________________________________________

Please send completed form and registration fee (payable to 'Rob Chen') to:

ROB CHEN
6014 VERANO PLACE
IRVINE, CA    92715-3159



This section contains many of the errors users encounter while using DigiCard. If you need technical 
assistance, please refer to this section first. If you are still stuck, please do not hesitate to contact the
author for help : - )

Runtime Error

If you encounter an abortive error while opening a DigiCard file (i.e., SAMPLE.CRD), make sure file 
sharing is activated on your computer. Using a text editor, check your AUTOEXEC.BAT file for 
SHARE.EXE. If Share is not present, add the following line to AUTOEXEC.BAT (assuming your DOS
directory is in the path):

SHARE.EXE /L:500

And reboot your computer. This should fix the problem. Please note that file sharing is innate to 
Windows for Workgroups and you do not need to load SHARE.EXE.

Multimedia Error

DigiCard talks to multimedia components entirely through Windows. In order for DigiCard to properly 
playback MIDI sound files, a sound card must be properly installed and recognized by the Windows 
MIDI Mapper. Likewise, to playback video for Windows AVI files, the driver must be properly installed.

If something does not work, test the multimedia component in question by playing the respective 
graphics or sound file through the Windows applet Media Player (in the Accessories Group). If you 
determined that the problem stems from DigiCard, please report the bug.

Print Error
DigiCard printing requires:
1 Windows-compatible printer capable of printing graphics (this is because all the cards are printed

as graphics). For higher quality output, raise the printer dot pitch through Printer Setup under the 
Files Menu.

2 Video mode be set to 8 bit (256 colors) at the time of printing.

The next DigiCard release will have a Study Sheet feature in addition to the 3x5" card printing. Study 
sheets will be essentially a list of question/answer pairs on the same side of the page. The new 
feature prints True Type Fonts, which means faster printing on all machines, regardless of color 
depth, to make printing even easier in DigiCard.



Evaluation
Thank you for using DigiCard. Please note that you may use DigiCard for a period not to exceed 45 
days for the purpose of evaluation. After this period, the author asks that you either register or 
discontinue the use of DigiCard. Registration of a single copy of DigiCard entitles the registrant the 
right to run it on a single computer at any given time.

Although the author makes his every best effort to ensure that DigiCard performs optimally and error-
free prior to release, users should carefully read and understand the disclaimer below before using 
DigiCard.

Disclaimer of Warranty
THIS SOFTWARE AND ON-LINE DOCUMENTATION ARE PROVIDED "AS IS" AND WITHOUT 
WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR ANY OTHER WARRANTIES 
WHETHER EXPRESSED OR IMPLIED. BECAUSE OF THE VARIOUS HARDWARE AND 
SOFTWARE ENVIRONMENTS THROUGH WHICH THIS PROGRAM MAY BE EXECUTED, NO 
WARRANTY OF FITNESS FOR    A PARTICULAR PURPOSE IS OFFERED. GOOD DATA 
PROCESSING PROCEDURE DICTATES THAT ANY PROGRAM BE THOROUGHLY TESTED 
WITH NON-CRITICAL DATA BEFORE RELYING ON IT. THE USER MUST ASSUME THE ENTIRE 
RISK OF USING THE PROGRAM. ANY LIABILITY OF THE AUTHOR WILL BE LIMITED 
EXCLUSIVELY TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE. USAGE OF 
THIS SOFTWARE CONSTITUTES AS ACCEPTANCE OF THE TERMS OF WARRANTY.



The following files are packaged into a single ZIP file for distribution. If any of the following files are 
missing or damaged, please contact the author for prompt replacement.

All files are installed to the DigiCard program directory.

n README.TXT Read this file first.
n FILE_ID.DIZ BBS description.
n VENDOR.TXT For shareware distributors and

Sysops of on-line services.
n DIGICARD.EXE DigiCard executable program and

DIGICARD.HLP On-line help file.
n SAMPLE.CRD Sample files

SAMPLE.CFG
FORMAT.CRD
FORMAT.CFG

n DIGICARD.REG Windows Registration Database files
UNREGIST.REG

n INSTALL.EXE DigiCard installation program.
INSTALL.INI

n CSCOMBO.VBX DigiCard system files.
CSHT.VBX
CSPICTUR.VBX
CSSPIN.VBX
CMDIALOG.VBX
FPTAB10.VBX
INICON3.VBX
MCI.VBX
THREED.VBX
APIGUIDE.DLL
COMMDLG.DLL
MSAES110.DLL
MSAJT110.DLL
VBDB300.DLL



Minimum Configuration:    
n 4 megs of RAM.
n 2.5 megs of disk space.
n VGA graphics.
n Microsoft Windows 3.1 (or compatible).
n A copy of VBRUN300.DLL in your \WINDOWS or \WINDOWS\SYSTEM directory.

Multimedia Features:    
n Windows compatible sound card (for digital WAVE audio and MIDI music).
n Microsoft video for Windows (AVI) driver.



VERSION 3.0 (3-10-95)

New Features:
n Multimedia support: True Color Pictures (BMP, GIF, PCX, TGA), Animations (MMM), Videos 

(AVI), Sounds (WAV), & Music (MID).
n Tab metaphor for easy access to file options and system preferences.
n Convenient access to virtually all initialization and configuration file information from within 

DigiCard (i.e., fonts, network access, etc).
n Full-text search ('Find') with field selection and forward/backward/exact search.
n 'Find Again', which is accessible from both the Edit menu and through the F3 key.
n Advanced keyword entry: Unique match and drop-down selections.
n Customizable labels (i.e., Question, Answer).
n Bookmark feature allows continuation of previous editing/review sessions.
n Working directory setting to facilitate file operations.
n Modules automatically sized to program window (option to turn on).
n Save program window size/location upon exiting DigiCard (option to turn on).
n Enhanced Viewer allows text formatting (underline, italics, bold & headline). Also, when text 

length exceeds the viewing area, scroll bar becomes available.
n Viewer-only setting loads Viewer by default and deactivates all editing functions.
n Sorting of any one of four fields by ascending or descending order (registration bonus).
n Command line and Program Manager loading of DigiCard (CRD) files. The file DIGICARD.REG 

associates the CRD extension with DigiCard, while the UNREGIST.REG file restores the CRD 
extension with Windows Cardfile Applet.

n Improved on-line documentation.
n Countless usability improvements.

Changes From v2.1:
n New install program.
n 'Find' (text search) moved from the Editor Module to the Tools Menu.
n New 'Tools' menu items replaces the 'Options' menu choices.

Bug Fixes:
n Totally new and enhanced print engine works with virtually all printers.
n No more duplication of file items in the File menu.
n Several minor KeyLink bugs eliminated.
n Discard record: now supports unlimited number of cards (previously 255 cards).
n General Protection Fault (GPF) upon exiting DigiCard on some systems now fixed.



VERSION 2.1 (5-1-94)

New Features:
n Undo typing feature to ease card composition and editing.
n Arrange icons function for asthetics.
n Card Shooter -- "hands free" presentation tool -- automatic timed presentation.
n File menu open items. The four most-recently opened files are represented sequentially under 

the file menu to speed up file opening.
n Editor Scripts available now as menu choices.
n Fonts - now you can use your favorite Windows fonts under DigiCard. Please see 'Tips and 

Tricks' section for instructions on how to change fonts.
n Read-only access. Please see 'Tips and Tricks' section for instructions on how to make files 

read-only.
n Network support. Please see 'Tips and Tricks' section for instructions on how to set up DigiCard 

for multi-user access.
n Print (registered version). Supports printing of any or all cards on Avery form 5388 or on any 8.5" 

x 11" paper. Preview allows you to format and edit cards to your liking before printing.

Changes from v2.0a:
n DIGICARD.INI is now located in the DigiCard program directory (you may now delete the 

DIGICARD.INI file located in the \WINDOWS directory).
n To access the 'Go To...' feature, click once on the card number indicator on the toolbar (i.e., 'Card

1 of 51'). The 'Go To...' button is replaced by the 'Scripts' button on the Editor and 'Shooter' 
button on the Viewer.

Bug Fixes:
n Viewer windows now support up to 32k bytes of text, rather than 1k. (Oops!)
n GPF when opening large files now fixed.
n 'Object variable not set' error followed by termination of DigiCard when opening is now 

eliminated. This error occurred on some users' machines because SHARE.EXE was not loaded.
n SHARE.EXE is no longer needed, unless 'Exclusive' (in the appropriate .CFG file) is set to false 

(i.e., networked access).

VERSION 2.0a (4-10-94)

Bug Fixes:
n [Escape] key now exits forms.
n Discard record now written to the appropriate .CFG file only. Previously it was written 

unnecessarily to both the .CFG file and DIGICARD.INI.
n Changes do not take effect now when cancel is selected from Viewer Options menu.
n When switching from KeyLink to other presentation styles while enabling all cards, not all cards 

were enabled. This is now fixed.
n Better error trapping when attempting to open non-DigiCard files.



VERSION 2.0 (3-15-94)

New Features:
n Implemented Microsoft Access 1.1 engine for data storage and handling. All DigiCard files are 

convertable to other database file types supported by Access (i.e., dBase, Fox Pro, etc.).
n Added two keyword fields per card.
n Added function for rapid search based on keywords.
n Enhanced the presentation module by adding KeyLink presentation.
n Simplified learning for novice users by adding context-sensitive help. This was done both in the 

form of status-line description of buttons and Windows help file when activated using the F1 key.
n Added the ability for the user to specify the default module upon start-up.
n Implemented a configuration file containing discard information and Viewer options unique to 

each DigiCard file.
n Bullet



How to Contact the Author

Why reinvent the wheel? To eliminate redundant work and to promote the spirit of sharing, the author
is starting the DigiCard Stack Library. The ultimate goal is to have hundreds of files covering diverse 
subjects, including foreign language, aviation, chemistry, medicine, history, mathematics, music, art, 
biology, philosophy, religion, business/economics, physics, literature, computers, social sciences, 
military sciences, etc. Descriptions of stacks will be posted in this section as well as in a separate 
document that will be sent upon request. Stacks in my possession will be available free of charge 
through e-mail and hopefully through FTP and BBS.

Since the library is still in its infancy, please contribute to the cause! You can contribute your stacks 
by the following ways: e-mail, surface mail, and uploading the file to Chips+ Connection BBS (please
see 'How to Contact the Author' section for addresses and phone numbers).

If you have an FTP site and would like to allocate a section for DigiCard Stacks, please let me know! 
An FTP site is urgently needed since I do not have the resources to start a site.

Finally, if you would like to market stacks that you have created, I would be happy to advertise it for 
you for free. Just send me a short description of 500 words or less plus contact information.



How to Contact the Author

As a valued DigiCard user, Graphics and text scanning are available to you at greatly reduced 
discounts (please note the price comparison against a national scanning service). For both graphics 
and text, dimensions up to 8.5x14" (legal size) are supported. Per your request, scanned outputs will 
be incorporated into DigiCard absolutely free.

Most orders will be processed within 24 hours of receipt and sent out via priority mail (US domestic) 
or air mail (international). Please e-mail or telephone if you have any questions.

Graphics    
n Scanning of pictures from black and white up to true color (16.7 million colors). Default is 256 

colors for non-black and white pictures.
n Pictures can be saved in any dimension up to 1024x768 and in any popular graphics format. 

Default is 640x480 in Windows BMP format.
n If you would like to customize color depth, dimension, and/or graphics format, please specify at 

the time of order.
n Price per picture: only $2.50 for black and white, $4 for color or greyscale (compare at $7.50 and

$10, respectively).

Text    
n Pages are scanned and converted to text using OmniPage Professional. Default format is ASCII 

text.
n If you would like to save the text under a popular word processor format, please specify at the 

time of order.
n Scanned text manually proofread to ensure accurate conversion.
n Price per page: only $2.50 (compare at $7.50).

Scanning Service Order Form



To print the following form, select 'Print Topic' from the File menu.

n Name: _______________________________________________________

Occupation: ____________________ Company: _____________________

Address: _____________________________________________________

City: _______________________    State: __________    Zip: ____________ 

Country: ________________    E-Mail or Telephone # __________________

n GRAPHICS:

# of Black and White: _____    x    $2.50 = $ _______

# of Color/Greyscale: _____    x    $4.00 = $ _______

n TEXT

# of Pages: _____    x    $2.50 = $ _______

n TOTALS

Subtotal for Graphics & Text: $ _______
(Less 25% if registered user)

Shipping and Handling: $          5.00
(Free $5.00 S/H if also ordering DigiCard)

Grand Total:               US $ _______

n Special Instructions:

____________________________________________________________

____________________________________________________________

____________________________________________________________

Most orders will be processed within 24 hours of receipt and sent via priority mail (US domestic) or 
air mail (international). All original documents will be returned. Please send completed form, 
document(s) to be scanned, and service fee (payable to 'Rob Chen') to:

ROB CHEN
6014 VERANO PLACE
IRVINE, CA    92715-3159





Perpetual Free Upgrades!
For a limited time, registered DigiCard users will be entitled to unlimited free upgrades! This special 
offer ends 9/1/95 and has no limit on the number of copies registered before this time. All other 
licensing agreements apply.



Automatic Upgrade Notification
If you would like to be notified by e-mail whenever DigiCard upgrades are released, send an Internet 
e-mail to: 

                                  listserv@stat.com

Include as the first line of the message the command:

                                  SUBSCRIBE UCI-FTP-UPDATE    

This is the periodic announcement list of the UCI Medical FTP Site, meaning that all other new 
uploads to the site will be announced as well. This should not be a problem as long as you don't 
mind scanning through other (potentially interesting) medical education-related uploads.



Welcome to the new DigiCard Help System. To see the help topics, simply click on a subject folder. 
To find what you need, you can also perform a keyword search ('Search' button above). If you are a 
first time user of DigiCard, please acquaint yourself with DigiCard by reading the Introduction section.

 Display All Topics

 INTRODUCTION
 Introducing DigiCard
 Who Benefits from DigiCard?
 Why is DigiCard Effective?
 USING DIGICARD
 REGISTRATION/SUPPORT
 RELEASE NOTES
 SPECIAL OFFERS
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Answer Window
n Contains the answer or response to the posed question.
n Length of text can be up to 32,000 characters. Text may be displayed with any combination of 

font attributes (see Text Formatting).
n To insert a Tab: [CTRL] [ALT] & [TAB].
n Tip: make the answer as direct and concise as possible, as this will enhance learning and 

retention.

See Also: Font Formatting



Text in the question and answer fields may display any combination of font attributes by using format 
codes. Unlike base attributes, use of format codes allows you to bold, intalicize, strikethru, underline, 
and enlarge the font size of selected segment of text. For information on how to change the basic 
font attributes, please refer to the Font Options section.

Format codes consist of a backslash character ('\') followed by a single character indicating the 
attribute. An uppercase letter used for an attribute enables the font attribute, while a lowercase letter 
disables the font attribute.

Format Code Font Attribute    
              \B, \b Bold
              \I, \i Italic
              \S, \s Strikethru
              \U, \u Underline
              \H, \h Heading (1.5x size of base font)

Please see the DigiCard file "FORMAT.CRD" for a demonstration of format code usage.

See Also: Font Options



Font Options
n Displays the basic font attributes (font name, size, bold, & italic) for all four fields. Changes to the

basic attributes of any field are transmitted to all cards of the stack. For information on how to 
italicize a word, for instance, please refer to the Font Formatting section.

n To change the base attribute, select the appropriate field and press the Change button. The font 
dialog will pop up.

n DigiCard supports all Windows compatible fonts. In order for DigiCard to use a font, it must be 
installed properly through Windows.

n Apply To: By default, changes will be saved to the current file only. Select 'System' if you want to 
make changes to DigiCard system but not the current file. Select 'Both' if you want the changes 
to transmit to both the current file and the DigiCard system.

See Also: Font Formatting



Auto-Discard
n Auto-Discard allows you to see each card once and only once per round of presentation.
n All cards are automatically enabled when all cards have been discarded, at which time the cycle 

starts again.
n Tip: This is especially useful for the beginning of a study session or before an exam, when you 

may want to see every card several times in a limited time period.



Bookmark
n If bookmark is selected, the card which is current at the time of exit will be marked automatically.
n the next time the file is opened, DigiCard will go directly to the marked card.
n Bookmark feature is used to maintain continuity of editing or review. You can come back to a 

session as you have left it without having to search for the card.



Card Number Indicator
n This displays the current card number / total number of cards in your DigiCard file.
n Click on this once to Go To another card.



Control Box
To exit DigiCard, click on this twice.



Copy
n Copies highlighted Editor text to the Windows clipboard.
n Clipboard contents can be shared with other Windows applications.
n Shortcut: [CTRL] [C].



Cut
n Cuts out highlighted Editor text to the Windows clipboard.
n Clipboard contents can be shared with other applications.
n Shortcut: [CTRL] [X] or [SHIFT] [DELETE].



Delete
n Permanently removes the current card from file.
n WARNING: Once your card is deleted from the file, it cannot be recovered. Take care in 

confirming delete operations.
n Shortcut: [Alt] [D] while in the Editor.



Directory Preference
n Set the directory where you work out of the most. File dialogs will default to the working directory 

setting.
n To change, simply type over the current directory setting. Directory format follows MS DOS 

conventions (i.e., C:\DIGICARD).



Discard
n Disables the current card.
n A click on this button temporarily inactivates the current card and keeps it from being displayed 

during Viewer presentations (note: this is not the same as delete).
n You can enable an inactive card by turning on its light bulb (button located on the toolbar). To 

activate all inactive cards, select the Enable All Cards check box under Options.
n Shortcut: [Alt] [D] while in the Viewer.
n Tip: Your study time can be used most efficiently when you discard those that you have already 

mastered. This allows you to use virtually all of your time acquiring new or unfamiliar information.



Drag 'n Drop
n Drag 'n Drop allows you to highlight a block of text and copy (drag) it to the target window (drop).
n Drag 'n Drop is on when it is checked under the Edit menu. Otherwise it is off (default).
n Shortcut: [CTRL] [D].
n Tip: This editing mode is most useful for importing text into DigiCard: simply highlight the import 

text and drag and drop it into the question or answer window.



Edit Menu
Undo Typing
Cut
Copy
Paste
Drag 'n Drop
Multimedia...



Undo Typing
n Undo text modifications since the last [backspace] key.
n Select again to undo the first undo operation.
n Shortcut: [CTRL] [Z].



Paste
n Pastes Windows clipboard text to the Editor.
n Clipboard contents may be from DigiCard or other applications.
n Shortcut: [CTRL] [V] or [SHIFT] [INSERT].



Add graphics and sound to your cards for a multimedia learning experience! Adding pictures, 
animations, videos, digital audio, and music is simple and straightforward. This section shows you 
how to add/remove multimedia files and lists the supported multimedia formats.

Each side of a card can display both graphics and sound simultaneously. For instance, you can 
display an animated sequence illustrating the basic manuvers of an airplane while a voice-over 
describes the operations.

Accessing the Multimedia Menu    
To edit the multimedia content of a card side, either:
1 Select Multimedia under the Edit menu; or
2 Right mouse click on a question or answer window.

A tabbed multimedia window will pop up. The default tab will be the current card side. You can select 
the other tab if you wish to edit the multimedia content of the opposite side.

Adding Multimedia Files    
To add a multimedia file, first select the file type, then press the File button. A file dialog will then pop 
up. Log on to the directory containing your file and make the selection.

In the Editor, your selected file will be displayed in brackets in the corresponding Question or Answer 
section. In the Viewer, all pictures are centered and pictures that are larger than the Viewer window 
will be shrunk to fit the viewer. Other multimedia formats will play automatically and can be controlled
through a panel near the upper-right corner of the Viewer.

Removing Multimedia Files    
To remove a multimedia file from DigiCard, click on the window displaying the file name. A 
confirmation dialog will pop up. Choose Yes to remove the file. Note that the multimedia add-in file is 
not deleted from the drive; it is simply removed from DigiCard presentation.

Graphics Formats    
n Picture: BMP, GIF, PCX, and TGA formats up to and including true color supported.
n Animation: MMM.
n Video: AVI (Microsoft Video for Windows).

Sound Formats    
n Digital Audio: WAV.
n MIDI Music: MID.



n This time-saving feature is designed to keep you from repetitive typing in the Editor.
n A script contains commonly used words, phrases, sententences, etc. that you use to formulate 

your questions, answers, and keywords. For instance, you may preface many questions with the 
phrase "What is the significance of..." Having this phrase as a script allows you to apply it very 
quickly.

n To add or edit a script, enter the text in one of the five text windows.
n Selecting the Clear All Scripts box followed by OK will clear all five scripts.
n Shortcut: [ALT] [S].

Applying Scripts    
To apply a script, you must first locate your cursor at the insertion point in the Editor. Then, you have 
a choice of either pressing the appropriate button in the Edit Scripts window or by selecting the 
proper item from the Scripts Menu.



Enable All Cards
n Check this box if you want to enable all of your cards for Viewer presentation.
n This option is available when one or more cards is disabled.
n Tip: You may enable or disable individual cards by turning the light bulb on or off, respectively.



Exit
n Selection exits DigiCard.
n If discard profile has changed, you will have a choice to save it before exiting.



File Items
n Displays recently opened files, 1 is most recent.
n Selection opens the file.



File Menu
New
Open
Save As...
Import Text
Printer Setup
Print
File Items (1-4)
Exit



New File
n Exits current DigiCard file and creates a new file ('Untitled').
n Shortcut: [CTRL] [N].



Open File
n By default, DigiCard files have the .CRD extension.
n Shortcut: [CTRL] [O].



Save As...
n Save your current DigiCard file under a new filename.
n By default, DigiCard files are saved with a .CRD extension.



Import Text
n Open a text file into TextPad.
n Text file must be under 32k and devoid of hard page breaks.
n Tip: For rapid importing of text, turn on Drop 'n Drop under the Edit menu.



Printer Setup
n Change parameters specific to your printer (i.e., quality, paper size, etc).
n For proper printing in DigiCard, please set your printer to portrait printing on 8.5x11" paper.
n To set the print quality, raise or lower the printer resolution (DPI or dot pitch).
n For more information, please refer to your printer manual.



Print
DigiCard supports text printing on 3x5" cards. The format is three cards per 8.5x11" sheet of paper. 
This layout is compatible to Avery form 5388 available from office supply stores. Since Avery forms 
can be expensive, a good compromise is to use heavy bond paper and leave crop mark printing on. 
Printing in DigiCard is a two step process:
n When Print is selected from the File menu, the Print Dialog will pop up. In the Print Dialog please

specify the range of cards to be printed as well as whether crop marks should be printed.
n The next step is Print Preview, where you have the option to preview each side of every card and

make adjustments if necessary.

Print Dialog
Print Preview



Print Dialog
In the print dialog, you can specify the range of cards you would like to print (see below). The Crop 
Mark option is checked by default. This allows the printing of 3x5" rectangles around each card for 
cutting if you are printing on plain (non-Avery) paper.
n Select 'All' if you want to print every card in the database.
n Select 'Current Card' if you want to print the currently displayed card.
n Select 'Cards' if you want to print a range of cards. Input the starting card number in the first 

blank, followed by the ending card number in the second blank.



Print Preview offers what-you-see-is-what-you-get (WYSIWYG) printing of your cards. The text and 
formatting you see in the preview window is exactly what will be printed.

To maintain the ability to print on both sides, all questions are printed first, followed by all answers. 
DigiCard will notify you to sort and re-feed the paper in between question and answer printing.

'Print Current' will print the card side currently displayed in the preview window. This is recommended
if you need to adjust the text format or position for each card side (see below).

'Print All' prints all of the remaining card sides (question or answer). In other words, if you are 
currently on the question side, all of the questions will be printed. A pause in the form of a dialog box 
in between each page is placed to prevent memory overload, since all printed data is in graphics. 
Print All is recommended if you do not need to format or position your text.

Adjusting Text Format and Position    
Since contents such as long passages of text may not physically fit in a 3x5" space, methods are 
available to format and position the text prior to printing. Also, you can bold or enlarge the size of the 
printed text by using the Bold Button and the Font Size Adjuster (see legend).

If the length of your text exceeds the preview screen, a scroll bar will pop up on the right side of the 
preview window. At this point, you have several options:

1 If the text is just a bit longer than the Preview Window, you can shrink the text to fit the window 
by using the lower button of the Font Size Adjuster. The scroll bar will disappear once you have 
all of your text contained within the window space.

2 If the text is significantly longer than the Preview Window, a compromise can be reached by 
homing in on a portion of the text you would like to print out. Use the scroll bar to scroll down to 
the part of the text you would like to capture.

Legend:    

    Bold Button

        Font Size Adjuster



File Name
Indicates the name of the current DigiCard file.



File Options
Viewer-Only Access
Network Access
Bookmark



Viewer-Only Access
n Select Viewer-Only Access if you want to disable all editing functions for the current file. If 

selected, file will default to Viewer on startup.
n Disabled components include: the Editor Module, Edit Menu, Scripts Menu, and Sort.



Network Access
n Select this option if you want to allow multi-user access to the current file on a network.
n The current file needs to be re-loaded for changes to take effect.



Find
n Searches the file for the occurance of a text string.
n Checked fields are active for searching.
n The direction of search can be forward or backward.
n Use 'Exact Match' to limit the search for your search string.
n Shortcut: [CTRL] [F].



Find Again
n Repeats the search request as defined in the Find Window.
n Shortcut: [F3].



Fixed Interval
n Select this option if you want a single fixed shooter interval (the time between turnover).
n Fixed interval is defined in terms of seconds (default is 3 seconds).
n This is the default Shooter setting.



Go To...
n Navigates the stack of cards in the current DigiCard file.
n Type in a card number directly or use the spin control to select a card.
n Shortcut: [CTRL] [G].



Help Menu
n You are currently in DigiCard Help. If there is a topic you would like to look up, press the 

Contents button above for table of contents or press the Search button to find what you want 
using specific keywords.

n Press [F1] for help on Windows Help.



Hide Keyword
n By default, the active keyword is automatically displayed in the status window during KeyLink 

presentation.
n Hide keyword will prevent the active keyword from being displayed.
n This option is available when using KeyLink.



Keyword Selection
n Selection allows you to limit the viewing of specific keyword(s). Keywords for each card are 

represented by the subject and topic fields.
n Simply highlight the desired keyword(s) and press OK to actuate keyword selection. To select a 

block of continuous keywords from the list, simply click and drag the mouse pointer to highlight 
the block of keywords. To select dispersed keywords from the list, press and hold the [CTRL] key
while making individual selections.

n Cards containing selected keywords are enabled; cards with non-selected keywords are disabled
(discarded).



Labels Options
n Labels of both the Editor and Viewer (i.e., Question and Answer) can be changed to your liking. 

Here are some suggestions: Cue/Response, Word/Definition, Greek/English, Structure/Function.
n To change a label, simply type over the old label.
n Apply To: By default, changes will be saved to the current file only. Select 'System' if you want to 

make changes to DigiCard system but not the current file. Select 'Both' if you want the changes 
to transmit to both the current file and the DigiCard system.



Discard Status
n Light bulb ON: current card is ACTIVE for Viewer presentation.
n Light bulb OFF: current card is INACTIVE.
n You can toggle the discard status of the current card by pressing the button thereby turning the 

light bulb on/off.



Maximize
Expands the main DigiCard form to fill the screen.



Minimize
Reduces the active module to an icon.



New Card
n Adds a new blank card to the end of the database.
n If the last card of the database is already a blank card, then you will go directly to that card.
n Shortcut: [ALT] [N].



Next Card
n Sequentially navigates the stack in the forward direction.
n Any changes made to the current card is saved automatically.
n Shortcut: [ALT] [>].



This section allows you to set options that are specific to the currently loaded DigiCard file. Changes 
occur immediately and all options are saved to the CFG file with the same name.

Tab Sections:
 Style
 Format
 Selection
 Shooter
 File
 Font
 Labels

Enable All Cards
Hide Keyword
Auto-Discard



Shooter Options
Fixed Interval
Relative Interval



Relative Interval
n Select this option if you want the shooter interval (the time between turnover) to adjust according 

to length of the text.
n Relative interval is set by reading speed in words per minute (wpm). Unlike the fixed interval, a 

larger wpm number will give a shorter delay. Default is 200 wpm.
n If the relative interval is selected, the fixed interval becomes the minimum amount of time a 

question or answer will display before turnover.



Percent Enabled
n Displays the percentage of cards that are currently active for Viewer presentation.
n Ranges from 100% (all cards enabled) to 0% (all cards disabled).



This section allow you to configure the DigiCard system. Changes occur immediately and all 
preferences are saved to the DIGICARD.INI file. 

Tab Sections: (Click on one)
 Screen
 Directory



Screen Preferences
Elastic Modules    
Normally, both Editor and Viewer Modules are fixed in size. Check this option if you want both 
modules to size in proportion to the outer program frame (i.e., to create more workspace).
Remember Position/Size    
If checked, DigiCard will save the positions and sizes of the major screen objects. On the next 
startup, object positions and sizes will be restored.
Monochrome Display    
Check this item if you are using DigiCard on monochrome units (i.e., portables).
Status Line Help    
Uncheck this item if you do not want status line help.



Previous Card
n Sequentially navigates the stack in the backward direction.
n Any changes made to the current card are saved automatically.
n Shortcut: [ALT] [<].



Question Window
n Contains a question or statement that will be elaborated upon in the Answer Window.
n Length of text can be up to 32,000 characters. Text may be displayed with any combination of 

font attributes (see Text Formatting).
n To insert a Tab: [CTRL] [ALT] & [TAB].
n Tip: make the question as direct and concise as possible. The desired effect is to have the 

question automatically trigger the answer in your mind.

See Also: Font Formatting



Repeat
n Redisplays the question.
n Shortcut: [ALT] [R].



Save
n The save button is activated during editing.
n Click on this button to save changes. For your convenience, when moving to another card 

changes are saved automatically.
n Shortcut: [ALT] [V].



Script Items
n To apply a script, you must first locate your cursor at the insertion point in the Editor. Next, 

selecting the proper item from the Scripts menu.
n With the Scripts Menu pulled down, Script Items are selectable by number.
n Shortcut: [SHIFT] [F1] to [F5].



Scripts Menu
Edit Scripts
Script Items (1-5)



Scroll Bar
Scrolls the text upward or downward.



Shooter Button
n Card Shooter is a "hands-free" presentation tool -- automatic timed presentation.
n Click once to start Card Shooter, again to stop.
n Shooting intervals can be set under the Shooter Tab in Options.
n Shortcut: [ALT] [S].



Show Answer / Next
n If a question is on display in the Viewer window, clicking on this button will reveal the answer.
n If an answer is on display, clicking on this button will advance to the next card. The card you get 

next will depend on the style of presentation (Sequential, Random, or KeyLink).
n Shortcut: [ALT] [N].



Sort (Registration Bonus)
n Any one of the four fields in DigiCard can be sorted. In the Sort dialog, select a field you would 

like to sort.
n Next, select a sort direction. Sort direction can be ascending (A to Z) or descending (Z to A).
n Press the Sort button to commence sorting.
n Discard record is automatically saved to the new order.
n Note: It is recommended that you back up the file before sorting if there is any possibility that you

would like to revert to the original order at a later time.



Status Window
n When you have questions about screen objects, point to the object and the Status Window will 

often display a short description.
n Under KeyLink presentation, the Status Window will display the current active keyword when the 

mouse pointer is placed above itself or the Show Answer button.
n Tip: Help descriptions can be turned off by de-selecting the Status Line Help box under 

Preferences.



Subject Window
n Subject and topic are the two types of keywords in DigiCard. Each card can have up to two 

keywords (one subject, one topic).
n Enter a keyword that best reflects the content of the current card. A re-current keyword can be 

selected from the pull-down menu to increase the entry speed.
n One advantage of assigning keywords to your cards is the ability to select one or more keywords

for viewing. Another advantage is the ability to utilize KeyLink Presentation (both selectable 
under Options).

n You can change the label (i.e., 'Subject') to better reflect your material by accessing the Labels 
Tab under Options.

See Also: Options



Switch to Editor Module
Activates the Editor Module.



Switch to Viewer Module
Activates the Viewer Module.



TextPad
n TextPad uses: copying of text into the Editor during file import and temporary scratch pad.
n TextPad is automatically activated when a text file is imported into DigiCard.
n TextPad contents cannot be saved -- it is a read-only storage space.
n Tip: Use drag and drop editing to save time. To turn it on, check Drag 'n Drop under the Edit 

Menu.



Tools Menu
Go To...
Find...
Find Again
Sort...
Options...
Preferences...



Topic Window
n Subject and topic are the two types of keywords in DigiCard. Each card can have up to two 

keywords (one subject, one topic).
n Enter a keyword that best reflects the content of the current card. A re-current keyword can be 

selected from the pull-down menu to increase the entry speed.
n One advantage of assigning keywords to your cards is the ability to select one or more keywords

for viewing. Another advantage is the ability to utilize KeyLink Presentation (both selectable 
under Options).

n You can change the label (i.e., 'Topic') to better reflect your material (Labels Tab under Options).

See Also: Options



Viewer Window
n Shows questions in red, answers in blue.
n Double-clicking the Viewer Window activates the Editor and allows editing of the current card.



Window Menu
Arrange Icons    
Arrange the Editor and Viewer icons to the lower left corner.
Editor    
Switch to Editor Module.
Viewer    
Switch to Viewer Module.






